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1. A ______ is a utility program that rearranges files and unused disk
space to optimise operations.  
 ________ एक यूटीलिटी प्रोग्राम  है, जो संक्रियओं के  अनुकू लन के  लिए फाइलो और
अप्रयुक्त डिस्क अंतरालों को  पुनर्व्यवस्थित करता है।

*
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2048×1536 Pixels

1240×480 Pixels

340×280 Pixels

540×450 Pixels
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Num Lock

Caps Lock

Arrow Lock

Shift
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Disk Cleanup Tool

Operating System

Utility software

Application software

2. 3 Mega Pixels (3 MP) means ______.  
 3 मेगा पिक्सल (3 MP) का अर्थ है ______।  

*

3.  To make the number pad act as directional arrows, you press the
______ key.  
नंबर  पैड को दिशात्मक तीर के  रूप में कार्य करने के  लिए, आप ______  कुं जी दबाते हैं।
 

*

4. What type of software is LINUX?   
LINUX किस प्रकार का सॉफ्ट वेयर  है?  

*
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Convert

Tools

View

File
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64 bits

74 bits

38 bits

16 bits
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serial

parallel

line

FireWire

5. Which of the following tab is NOT available in OpenOffice 4.0 main
menu? 
 निम्न में से कौन सा टैब ओपन ऑफिस 4.0  मेन मेन्यू  में उपलब्ध नहीं  है?

*

6. The word size of the most modern general purpose computers usually
is ______. 
   वर्तमान में सामान्य उद्देश्यों के  लिए प्रयुक्त होने वाले  कंं म्‍प्‍यूटरों  का शब्द आमाप
(word size) सामान्यतः  ______ होता  है।

*

7. A ______ port transmits one bit at a time. 
  ______ पोर्ट , बिट्स की एक स्ट्री्  म के  रूप में एक बार में एक बिट को प्रसारित करता है।

*
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Option 1 Option 2

Option 3 Option 4
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MIHIR

PARAM 8000

PRATYUSH

EKA

8. Which of the following icons indicates that a file or folder is in the
process of updating in the Dropbox folder on your computer?  
 निम्न में से कौनसा आइकन इंगित करता  है कि आपके  के   कं म्‍प्‍यूटर पर  ड्राॅ पबॉक्स
फ़ोल्डर  में कोई फ़ाइल या फ़ोल्डर अपडेट होने की प्रक्रीया में  है?

*

9. Which of the following is considered to be the first supercomputer
developed in India, by C-DAC? 
  भारत में सी-डैक (C-DAC) द्वारा विकसित पहला सुपर कं प्यूप्टर निम्न में से किसे माना
जाता है?

*
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System bus

Memory

Storage

CPU
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AGV

AGI

AGC

AGP
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12

3.

14

144

10. Which of the following is used to get the processed information i.e,
output by submitting input to the computer? 
निम्नलिखित में से किसका उपयोग प्रोसेस्ड जानकारी यानी , कं प्यूटर में इनपुट सबमिट
करके  आउटपुट प्राप्त करने के  लिए कि‍या जाता है?

*

11. An ______ is an advanced port designed for video cards and 3D
accelerators 
  ________ एक उन्नत पोर्ट है, जिससे वीडि‍यो कार्ड  3D एक्सेलेरेटर के  लिए डि‍ज़ाइन
किया गया  है।

*

12. What is the value of the following MS-Excel function, =FLOOR(14,4)?  
 MS-Excel फ़ं क्शन =FLOOR(14,4) का मान क्या होगा ?  

*
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Scalability

Speed

Accuracy

No IQ
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Capacitive and Resistive Sensors

Smoke Sensors and LM35

LM35 and Accelerometer

Accelerometer and Smoke Sensors
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2.

16

8

4.

13. The ability to do error-free calculations represents the ________
characteristic of the computer. 
   कं प्यूटर द्वारा त्रुति रहित गणनाएं  करने की वि‍शेषताएं  क्या कहलाती हैा

*

14. Which of the following are two most commonly used types of touch
sensors with reference to Io T products?
   Io T उत्पादों के  संदर्भ में, निम्नलिखित में से कौन से दो सार्वार्धिक उपयोग किए जाने
वाले टच सेंसर हैं?

*

15. Each MIDI interface supports how many channels?
   प्रत्‍येक एम.आई.डी.आई. (MIDI) इंटरफ़े स कितने चैनल्स का समर्थन करता है?        

*
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server

super computer

network

enterprise
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.avi

.msi

.EC3

.mp3
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Integrated

Inner

Internal

Inbuilt

16. Personal computers can be connected together to form a ______. 
  व्यक्तिगत कं म्‍प्‍यूू टरों को एक दू सरे  से जोड़ के  एक ______ बनाया जा सकता  है।  

*

17. Which of the following file format is used by windows installer during
windows installation? 
   विंडोज़ इंस्टॉलर द्वारा विंडोज़ इंस्टॉलेशन के  दौरान निम्न  में  से किस फाइल फॉर्मेट का
उपयोग किया जाता है?  

*

18. ISDN stands for _______ Services Digital Network.
   ISDN  का अर्थ है _______ सर्विसेस डिजिटल नेटवर्क  ।

*
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Application Gateway

Application Switch

Application Security

Application Hub

1/1

150

15

160

5
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device that takes information from computer and prints it on a paper.

device that stores information.

device that processes the information.

device to scan and print the information on a monitor.

19. Application firewall is also known as:    
एप्लिके शन फ़ायरवॉल को ______ भी कहा जाता है ।  

*

20. What will be the output of the following excel formula?
=CEILING.MATH(155,10)  
 निम्नलिखित एक्सेल फॉर्मूला का आउटपुट क्या होगा ?=CEILING.MATH(155,10)

*

21. Printer is a: 
  प्रिंटर एक:  

*
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Dot matrix

Mechanical

Laser

Inkjet
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Sheet feeder

Print preview

Print spooler

Print taper

1/1

Wireless Devices

Input Devices

Peripheral Devices

Network

22. _____ printers essentially spray ink onto paper through a nozzle in
microscopic droplets. 
  _____  प्रिंटर वास्तव में एक नोजल के  माध्यम से सूक्ष्म छिं टो (बूंदों)  के  रूप में कागज
पर स्याही छिड़कते हैं।  

*

23. ______ is a device found on a computer printer that accepts track of
paper and feeds them through the machine one by one. 
   ______ एक कं प्यूटर प्रिंटर पर पाए जाने वाले डिवाइस  हैं जो कागज का ट्रै क स्वीकार
करते  हैं और उन्हें निम्‍न के  माध्यम  से एक-एक करके   फ़ीड करते  हैं।  

*

24. Devices such as monitors, printers, and keyboard, that connected to
the computers are collectively called as ______. 
कं प्यूटर से जुड़े मॉनिटर,  प्रिटर और की बोर्ड जैसे से उपकरणों को सामूहिक रूप से 
______ कहा जाता है।  

*
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Dirty

Lossy

Lossless

Clean
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Secret

Personal

Shared

Public
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device address

automatically assigned network address

gateway address

broadcast address

25. ______ compression technique can NOT completely recover original
data.   
 ______ संपीड़न तकनीक  पूरी तरह से से मूल डेटा पुनर्प्राप्त नहीं  कर सकता है है।

*

26. ______ key algorithms uses one key for encryption and another for
decryption.  
 ______  कुं जी एल्गोरिथम एन्क्रिपशन के  के  लिए किसी एक का और डिक्रिपशन के  के
लिए किसी  दू सरी कुं जी का उपयोग करता है।

*

27. In IP address 192.168.1.255, 255 is assigned as:  
IP एड्रे स 192.168.1.255 में में 255 को किस प्रकार असाइन किया गया है?

*
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(1) Create New virtual machine using Windows OS (2) Select OS and its version (3)
Locate ISO file of that OS (4) Install OS (followsscreens) (5) OK

(1) Create New virtual machine using Linux OS (2) Select OS and its version (3)
Locate ISO file of that OS (4) Install OS (follows screens)(5) OK

(1) Install VMWare (2) Click New virtual machine (3) Select OS and its version
(4) Locate ISO file of that OS (5) Install OS (followsscreens) (6) OK

(1) Install VMWare (2) Click New virtual machine (3) Select OS and its version (4)
Install OS (follows screens) (5) OK
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HDD

ROM

PROM

EEPROM

1/1

Psycho-visual Redundancy

Inter-pixel Redundancy

Time Redundancy

Coding redundancy

28. When using WINDOWS, what are the general steps to Install an OS
using VMWare?  
WINDOWS का उपयोग करते समय, VMWare का उपयोग करके   OS स्थापित करने
के  सामान्य चरण क्या हैं?

*

29. Operating system resides:  
ऑपरे टिंग सिस्टम ______ रहता  है।

*

30. Which of the following is NOT a type of redundancy used in image
compression?  
निम्नलिखित में से से क्या छवि संपीड़न में उपयोग की जाने वाली अतिरेकता का एक
प्रकार नहीं   है?

*
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Cookies

Plug-ins

Scripts

ASPs

1/1

updates

promotions

forums

primary
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Alt+F1

Alt+F2

Ctrl+K

Ctrl+B

31.______ are used to identify a user who returns to a website.
______ का उपयोग किसी  वेबसाइट पर लौटने ने वाले  उपयोगकर्ता  की पहचान करने
के  लिए किया जाता है।

*

32. In Gmail, deals and offers are part of the ______ tab. 
 Gmail में सौदे  और प्रस्ताव ______  टैब का हिस्सा हैं।

*

33. What is the shortcut key used to insert hyperlink in MS-PowerPoint
2016?  MS-PowerPoint 2016 
में हाइपरलिंक प्रविष्ट करवा ने  के  लिए उपयोग की जाने ने वाली 
शॉर्टकट कुं जी क्या  है?

*
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Plickers

Flickers

Scanners

Pluckers

1/1

20,000

100,000

50,000

25,000

34. Which of the following is a free app developed by Nolan Amy that can
be used on IOS or Android operating system for pre-assessments,
checksfor understanding, polls or class surveys, tickets out the door,
TCAP review, etc? 
 निम्नलिखित में से कौन सा नोलन एमी द्वारा विकसित एक ऐसा निः शुल्क ऐप है जिसका
उपयोग IOS अथवा एं ड्रॉ इड ऑपरे टिंग 
सिस्टम पर पूर्व - मूल्यांकन, समझ की जांच, मत या वर्ग  सर्वेक्षण, बाहर से से टिकट ले
लेने ने, TCAP समीक्षा आदि के  लिए किया जा सकता है?

*

35. What is the maximum per transaction limit for sending money in
BHIM payment interface as of January 2022? 
 जनवरी 2022 तक की स्थिति के  अनुसार, भीम (BHIM)  पेमेंट  इंटरफ़े स में पैसे से
भेजने ने के  लिए प्रति ट्रां जेक्शन (transaction) की अधिकतम सीमा क्या है?

*
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Doughnut

Clustered

Stacked

Bar

1/1

Useful when you want to find optimum combinations between two sets of data.

Uses chart when both categories and data series are numeric values.

This type of chart requires four series of values in the correct order (open, high,
low, and then close).

3-D surface charts show trends in values across two dimensions in a continuous
curve.

1/1

antivirus

Google Meet

plickers

MS Word

36. Which of the following types of pie chart contains more than one data
series at a time in MS-Excel 2016?  MS-Excel 2016  में, निम्नलिखित  में  से किस
प्रकार  के  पाई चार्ट में  एक समय में एक से अधिक डेटा श्रृंखला होती है?

*

37. Which of the following statements is INCORRECT with respect to
surface chart in MS-PowerPoint 2007?    

MS-PowerPoint 2007 में, सर्फे स चार्ट  के  मामले में कौन-सा कथन गलत है?

*

38. To conduct voice chat with your family and friends, you need to use
______.  

अपने  परिवार और मित्रों के  साथ वॉइस चैट करने के  लिए आपको ______ का उपयोग
करना होगा ।

*
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Google

Web log

Word processor

Microsoft outlook express
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Paragraph Case

Section Case

Sentence Case

Toggle Case
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line spacing

more dots

square caps

line caps

39. ______ is a type of personal website where articles are regularly
posted.  ______
 एक प्रकार की व्यक्तिगत  वेबसाइट  है जहाँ नियमित रूप से लेख पोस्ट किए जाते  हैं।  

*

40. Which of the following options is used to capitalize the first letter of a
sentence and leave all other letters as lowercase in MS-Word
2016document? 

 MS-Word 2016 डॉक्युमेंट  में, निम्न लिखित  में से किस विकल्प का प्रयोग वाक्य  के
पहले  अक्षर को बड़े अक्षरों  (capital) में लिखने और अन्य सभी अक्षरों  को लोअर  के स 
के  रूप  में छोड़ने  के  लिए किया जाता  है?

*

41. In computer graphics, we can adjust the shape of the line ends to give
them a better appearance by using:  

*
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Widow/Orphan control

Page break before

Keep with next

Keep lines together
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next page

continuous

even page

odd page

42. Which of the following pagination controls in the Line and Page
Breaks tab places at least two lines of a paragraph at the top or bottom
of a pagein MS-Word 2019?

  MS-Word 2019  में, लाइन और पेज ब्रेक्स टैब में निम्न लिखित में में  से कौन-सा
पेजिनेशन नियंत्रण (pagination controls) एक  पेज  के  ऊपर या नीचे पैराग्राफ की
कम से  कम दो लाइनों  को रखता  है?

*

43. A/an ______ section break lets you start a new section on the next
odd-numbered page in MS-Word 

2016.  MS Word 2016 में______ सेक्शन  ब्रेक आपको अगले  विषम संख्या वाले  पेज
पर एक नया  सेक्शन  शुरू करने  देता  है।

*
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Spelling & Grammar

Research

New comment

Word count

1/1

ruler

header

footer

balloons

44. Which of the following options in MS-Word 2010 is NOT present in the
proofing ribbon? 

MS Word 2010  में, अशुद्धि  जांच (प्रूफिं ग) पट्टी में निम्न में से कौन सा विकल्प मौजूद
नहीं  है?

*

45. In MS-Word 2007 revisions, changes, and corrections are typically
shown in the ______ near or in the margin of the page. 

 MS-Word 2007  में  पुनरीक्षण, परिवर्तन और  सुधार आमतौर पर पृष्ठ  के  पास या
मार्जिन  में ______   दिखाए जाते  हैं।

*
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Quick tables

AutoFit contents

AutoFit to window

Insert Table -> Number of columns

1/1

CTRL+F1

CTRL+F4

CTRL+F3

CTRL+F2

46. Raghu wants to create a table in MS-Word 2013 with five columns;
which of the following option must he choose?  

रघु MS-Word 2013  में  पांच कॉ लम वाली तालिका बनाना चाहता  है, उसे निम्न
लिखित  में  से कौन सा विकल्प चुनना चाहिए?

*

47. Which of the following shortcuts can be used to see the Print Preview
of the MS-Word 2019 document? 

 MS-Word 2019 डॉक्युक्युमेंमेंट का प्रिंट प्रिव्यू  देखने ने के  लिए
 निम्न में  से किस शॉर्टकट का उपयोग किया जा सकता  है

*
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Mailings

References

Page layout

Design
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Menu > PivotTable > Insert > Create PivotTable > Range

Menu > PivotTable > Insert > Range > Create PivotTable

Menu > Insert > PivotTable > Create PivotTable > Select table or Range

Menu > PivotTable > Create PivotTable > Insert > Range

48. Reena wants to change the font style of the return address of an
envelope during mail merge process in MS-Word 2019. Which of the
following options are used? 

 रीना MS-Word 2019  में, मेल मर्ज  (mail merge) प्रक्रिया के
दौरान एक लिफाफे  (envelope)  के  रिटर्न  एड्रे स की फ़ॉन्ट  शैली को बदलना चाहती है।
निम्न लिखित में  से किस विकल्प का उपयोग किया जाता  है?

*

49. Which of the following is the correct order of action to create a pivot
table in MS-Excel 2016? 

 MS Excel 2016 में, पिवोट  टेबल बनाने के  लिए निम्न  में  से कौन सा क्रिया का सही
क्रम  है?

*
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File (office Button) – open – select all word template from dialouge box

Cannot open readymade templates

File (office Button) – New – Sample Template – Select any template from
available templates

File – Open – select Templates

1/1

Alt + P

Atl + N

Alt + H

Alt + G

50. What are the steps to open new ready made templates in MS-Word
2010?  

MS-Word 2010  में, नया  पूर्व -निर्मित  टेम्प्लेट खोलने ने  के  लिए निम्न में से किन चरणों
का अनुसरण करना होगा ?  

*

51. Which of the following ribbon navigation short cut key is used to go to
Layout tab in MS-Word 2019?  
 
MS-Word 2019  में, लेआउट टैब पर जाने के  लिए निम्न  में से किस रिबन  नेविगेशन
शॉर्टकट की (key) का उपयोग किया जाता है?

*
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Audio player

MP3 player

Media player

Audio CD player

This content is neither created nor endorsed by Google. - Terms of Service - Privacy Policy

Does this form look suspicious? Report

52. Which of the following is capable of playing audio and video streams?
 

निम्न में  से कौन-सा ऑडियो और वीडियो स्ट्री म को चला  ने (playing) में सक्षम है?

*
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